
C h a p t e r 12
 

Revolving Problem 
One 
 

 
In this chapter, you will learn the following to World Class standards: 

 
 Sketch of Revolving Problem One 
 Starting a 3D part drawing 
 Modifying UCS settings 
 Drawing a centerline using the Line command 
 Creating a perimeter using the Polyline command 
 Adding curved edges using the Fillet Command 
 Revolving a solid from a closed polyline 
 Rotating a 3D solid using the 3D Rotate command 
 Remove the center line using the Erase command 
 Drawing a solid cylinder 
 Moving a solid into position on the master solid 
 Creating an array of a solid using the Array command 
 Subtracting 3D solids from the master solid 
 Hiding the solid 
 Moving the solid to the origin point 
 Saving the Solid Problem 
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Sketch of Revolving Problem One 
________________________________________________________ 
 
You will start the first revolving problem with a rough sketch showing the dimensions of each 
detail. This part is symmetrical across the XZ plane. In this exercise, you will draw and 
revolve a closed Polyline that contains the most complex shape of the component and then use 
simple geometric solids to subtract each additional detail.  Revolving problem one’s master 
solid contains radius edges in the main shape that you will place using the Fillet tool.  After 
revolving the polyline perimeter, you will place a cylinder onto the master solid, and then 
create an array of the cylinder to subtract. Finally, you will utilize the Chamfer command and 
put a beveled entry on the three mounting holes and the hole in the hub. 
 

 
Figure 12.1 – Revolving Problem One sketch
 
Remember, when you receive a sketch from a professional, quickly identify the different 
shapes and deciding how to begin the drawing. You will find that using this strategy of 
revolving a closed perimeter is very effective for creating circular parts.  Place as much detail 
in the perimeter and interior detail as possible, so that you will have less detail to add to the 
3D solid.  All of the drills in the Fundamentals of 3D Drawing textbook will walk you 
through such common repetitive maneuvers that you will use often in 3D modeling. 
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Starting a 3D Part Drawing 
________________________________________________________ 
 

You will begin Revolving Problem One using the Mechanical template.  First select 
the New tool on the Quick Access Toolbar. A list of templates is loaded in the “Select 
template” window.  Scroll down the list and select Mechanical.dwt. A new drawing 
file will open that contains the system variables and layer definitions which you will 
use later in Paper Space to finish the drawing. 
 

 
 

Figure 12.2 – Starting the drawing using the Mechanical template 
 
 
 

Modifying UCS Settings 
________________________________________________________ 
 
You may notice the UCS icon moving on the graphical display as you zoom or pan your view.  
If so, the UCS is currently representing the origin (0,0,0) of the drawing area.  This can 
sometimes be distracting, especially if the origin happens to lie in the vicinity of your 
drawing.  You can change the UCS settings so that the icon is always displayed in the bottom 
left-hand corner of the drawing area. Select the Show UCS Icon tool from the Coordinates 
panel under the Home tab (Figure 12.3) and select the “Show UCS Icon” option (Figure 12.4). 
You also have the choice of keeping the UCS displayed at the origin or turning it off 
completely.    
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Figure 12.3  -  The Coordinates panel Figure 12.4  -  Changing the UCS display 

settings 
 

 
 

Creating a Center Line Using the Line Command 
________________________________________________________ 
 
First, you need to draw a centerline with the Line tool from the Draw panel.  Select a 
start point of the line in the bottom left-hand corner of the screen.   
 

With the Ortho mode “on”, drag the cursor to 
the left and type “2.25”.  Hit ENTER to 
complete the function. A line will appear on 
your graphical display as shown in Figure 
12.5.  

  
Figure 12.5 – The centerline  

 
 
 

Creating a Perimeter Using the Polyline Command 
________________________________________________________ 
 
Now you will create the closed polyline that you will then rotate around the 
centerline to create the master solid.  You will create the polyline above the 
centerline and then use the Move command to place the outline in position. 

 
 

 
Command: _pline 
Current line-width is 0.0000 
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: 2.25  
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: 2.75  
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 0.875 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: .25 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: .25 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 2 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 1.625 
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: c 
 
Figure 12.6 – The command line prompts for the Polyline command 
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With the Ortho mode “on”, use the Polyline 
command to start a line on the left endpoint 
of the centerline.  Draw a 2.25 unit line to the 
right, a 2.75 line up, a 0.875 line to the left, a 
0.25 line down, a 0.25 line to the right, a 2.0 
line down, a 1.625 line to the left, and then 
type “C” and ENTER to close the Polyline. 
A closed outline will appear in the graphical 
display.  Now use the Move tool to move the 
outline 0.5 units above the centerline as 
shown in Figure 12.7.   

  
Figure 12.7 – Polyline moved above the 
centerline 

 

 
 
 

Adding a Curved Edge Using the Fillet Command 
________________________________________________________ 
 
You placed a curve on the edge of a 3D solid in a previous problem, but on this 
exercise you will change the Polyline entity by placing the arc in the 2D perimeter 
before revolving it around the centerline. 

 

 
Select the Fillet tool on the Modify panel and then type R and ENTER.  Type 0.125 and 
ENTER to set the system for a 1/8 radius arc.  Also type M and ENTER so you can place 
multiple 0.125 arcs on the perimeter.  Select the vertical line as shown in Figure 12.8, and 
then select the horizontal line as shown in Figure 12.9.  The 0.125 arc will appear on the 
corner of the polyline as shown in Figure 12.10. 
 

  

Figure 12.8 – Selecting the first edge Figure 12.9 – Selecting the second edge 
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Continue to place arcs using the same 
technique.  The next arc is just to the right of 
the first and the radius is still set, so select the 
horizontal and vertical line to place another 
arc as shown in Figure 12.11. The third 
curved segment as shown in Figure 12.12 is 
above the second. You may want to zoom 
closer to make the selections for the fourth 
arc as shown in Figure 12.13 and the fifth 
fillet as shown in Figure 12.14  

  

Figure 12.10 – 0.125 arc on the polyline  

 

  
Figure 12.11 – The second fillet Figure 12.12 – The third fillet 
  
Remember that you can use the Fillet command in 2D or 3D. When you use the tool in 2D, 
you must select two lines to describe the corner on which you want to add the curve. When 
you are utilizing the tool in 3D, you only select the edge because it represents the intersection 
of two lines. Both techniques are effective.   
 

  
Figure 12.13 – The fourth fillet Figure 12.14 – The fifth fillet 
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Revolving a Solid from a Closed Polyline 
________________________________________________________ 
 
After you add the last fillet, you are ready to revolve the closed Polyline into a very 
complex 3D Solid.  You will use the centerline for the axis of rotation when turning 
the perimeter into the solid.  
  
Select the Revolve tool by clicking on the drop-down arrow below the Extrude icon on the 
Modeling panel and selecting the Revolve tool.  The command line will prompt you to “select 
objects”. Pick the perimeter of the Polyline and the command line will return with “1 found” 
as shown in Figure 12.15.  Next, you choice two points to describe the axis of rotation. Pick 
the left endpoint Osnap of the centerline as shown in Figure 12.16 for the first point. Pick the 
right endpoint Osnap of the centerline as shown in Figure 12.17 for the second point.  
  

  

Figure 12.15 – Select the polyline Figure 12.16 – The first point of the axis 
  
You will then be prompted to “Specify angle of revolution or [STart 
angle/Reverse/EXpression] <360>:”.  Hit ENTER to rotate the part 360 degrees.  After 
defining the angle of revolution, a new master solid will appear on the graphical display. 
Select the Southwest Isometric View to allow you to see the part in three dimensions more 
clearly as shown in Figure 12.18. 
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Figure 12.17 – The second point of the axis Figure 12.18 – The revolved solid 
 
 
 

Rotating a 3D Solid Using the 3D Rotate Command 
________________________________________________________ 
 
Select the 3D Rotate command on the Modify panel. At the prompt “select objects”, pick the 
solid on the graphical display and hit ENTER.  Now select the bottom quadrant Osnap as the 
base point of rotation.  Specify the Y axis as the axis of rotation by selecting the circle that 
orbits the Y axis (Figure 12.19).  With the Ortho mode “on”, specify an angle start point and 
then use the cursor to move the solid 90 degrees clockwise (Figure 12.19).  Finish the rotation 
by clicking with the left mouse button and the solid will appear rotated on its base as shown in 
Figure 11.12. 
 

  
Figure 12.19 – Specifying angle end point Figure 12.20 – The rotated solid 
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Removing the Center Line Using the Erase Command 
________________________________________________________ 
 

Don’t forget to erase the centerline that you 
used as the axis of revolution after you rotate 
the solid on its base.  Select the line and hit 
DELETE on the keyboard or use the Erase 
command from the Modify panel.  It is 
always important to remove construction 
entities as you go along so that they do not 
interfere with the details you will continue to 
add to a drawing.   

  

Figure 12.21 – The centerline erased  

 
 
 

Drawing a Solid Cylinder 
________________________________________________________ 
 
You need to add three holes to the master solid: one 0.5 diameter hole going 
completely through the master solid, and two more identical 0.5 diameter holes that 
will you will create with the Polar Array command.   
 

  
Figure 12.22 – Placing the cylinder Figure 12.23 – The cylinder  
 
Select the Cylinder tool on the Modeling panel under the drop-down arrow beneath the Box 
command. Specify the center point for the base of the cylinder as the center Osnap of the 
middle of the part. Type “D” for diameter and hit ENTER and input the sketch’s 
measurement of 0.5. Hit ENTER to go to the next prompt, which is to “specify the height of 
the cylinder”. With Dynamic Input toggled “on”, pull the cylinder down into the master solid, 
type 0.875 for the height of the cylinder and hit ENTER (Figure 12.22). The cylinder will 
appear as shown in Figure 12.23.  If you do not have Dynamic Input on type -0.875 to pull the 
cylinder -0.875 units on the Z axis. 
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Moving 3D Solids into Position on the Master Solid 
________________________________________________________ 
 
The Move command is actually a three-dimensional function in the modern AutoCAD 
application software program. The way you can determine whether a command is 
three dimensional in nature is to attempt to use the function outside the Z-plane, that is 
the Z coordinate is not 0. You can use move to relocate any entity to another point 
(X,Y,Z) in Model Space. 
 

  
Figure 12.24 – Moving the cylinder Figure 12.25 –The cylinder in position 
  

To move the cylinder, select the Move tool on the Modify panel.  Once you choose the Move 
command, the prompt will be “Select Objects”.  Pick the cylinder and the command line will 
respond with “1 found”, so just press ENTER to go the second part of the command.  Next 
you need to “specify base point or displacement”, which will be anywhere on the graphical 
display as shown in Figure 12.24.  For the “second point of displacement”, move the cursor to 
the right with the Ortho “On”, type 2.0 and ENTER. The cylinder will be ready to polar array 
as shown in Figure 12.25. 
 
 
 

Using the Array Command to Create Circular Patterns 
________________________________________________________ 
 
You now need to copy and rotate the solid cylinder, spacing each one 120 degrees 
apart. Use the Polar Array function for this operation. 
 
Select the drop-down arrow next to the Array tool on the Modify panel and select the Polar 
Array tool.  First you will be prompted to select objects, so select the cylinder and hit ENTER 
(Figure 12.26).  Next you need to specify the center of your polar array, so select any center 
Osnap point that corresponds with the middle of the master solid (Figure 12.27).  Enter 3 for 
the number of items, and when prompted to specify the angle to fill type 360 and ENTER 
(Figure 12.28).  Two more cylinders should appear so that each is 120 degrees from the other 
as shown in Figure 12.29. 
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Figure 12.26 –Selecting Objects Figure 12.27 – Center of the Polar Array  
 

 
Figure 12.28 – Subtracting Solids Figure 12.29 – Subtracting Solids 
  
  
  

Subtracting 3D Solids from the Master Solids 
________________________________________________________ 
 
Before subtracting the solids, you must explode the polar array by selecting the 
Explode too from the Modify panel and then selecting the array and hitting ENTER.  
Now you are ready to subtract the three cylinders from the master solid.   

 

  
Figure 12.30 – Selecting the cylinders Figure 12.31 – The subtracted solids 
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To remove the cylinders from the master solid, select the Subtract tool on the Solid Editing 
panel.  The command line will prompt you to “Select solids and regions to subtract from”. 
Select the master solid and the system will respond with “1 found”.  Hit ENTER to proceed 
to the next step, which is to “Select solids and regions to subtract”. Pick the three cylinders 
inside of the master solid and the command line will respond with “3 found” (Figure 12.30).  
Hit ENTER and the shape of the two cylinders will disappear from the master solid as shown 
in Figure 12.31.   
 
 
 

Adding a Bevel Edge Using the Chamfer Command 
________________________________________________________ 
 
You can use the Chamfer command to add a beveled edge to the three holes.  In many 
parts, adding a broken edge will help the worker during assembly. 
 

  
Figure 12.32 – Selecting edges Figure 12.33 – Four chamfered edges 
  
On the Modify panel, select the drop-down arrow next to the Fillet tool and then select the 
Chamfer tool. Use the pick box to select the top edge of one of the 0.5 holes (Figure 12.32). 
Hit ENTER, and then type “0.0625” for the offset distance. Hit ENTER and type “0.0625” for 
the second offset distance. Hit ENTER once more, and also type M and ENTER so you can 
then select the top edge of each 0.5 hole on the master solid.  Hit ENTER and the 0.0625 by 
45-degree chamfer will appear on the edge of the each hole as shown in Figure 12.33. 
 
Repeat the Chamfer command by hitting ENTER on the keyboard, and place another bevel on 
the inside edge of the middle hole of the master solid as shown in Figure 12.33 
 
 
 

Hide the 3D Solid 
________________________________________________________ 
 
In Figure 12.33, you will notice that the tessellation lines representing the solid’s 
outline on the far edge of the part are visible. In a real world solid part, you would not 
be able to see through the solid unless its material was transparent. You can use a 
different visual style to remove the hidden lines from your graphical display. 
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Select the Realistic visual style from the 
Visual Style panel under the View tab.  The 
part will appear rendered with a metallic sheen 
as shown in Figure 12.34.  If you wish to 
return the graphical display to the previous 
visual style, choose the visual style called 2D 
Wireframe. Neither command alters the mass 
of the solid or any of the dimensions, but both 
are available for the computer aided designer 
as a viewing option. 

  
Figure 12.34 – The Realistic visual style  

  
  
  

Moving the Solid to the Origin Point 
________________________________________________________ 
 
To move Revolving Problem One to the drawing origin of 0,0,0 on the x, y and z axis, select 
the Move tool from the Modify panel under the Home tab, select the 3D solid, and hit 
ENTER.  At the prompt “specify base point or displacement,” select the center Osnap of the 
bottom of the part as shown in Figure 12.35, which will become its insertion point into an 
assembly drawing.  At the “second point of displacement,” type 0,0,0 and ENTER, or #0,0,0 
and ENTER if using Dynamic Input. Revolving Problem One will move to the origin point.  
Moving a part at the origin is important for when you wish to insert the solid into an External 
Referenced Assembly drawing. 
 

 
 
Figure 12.35 – Moving the finished solid to the origin 
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Saving the Solid Problem 
________________________________________________________ 
 
To save Revolving Problem 1 in your Fundamentals of 3D Drawing Folder, select the 
Save As tool on the Quick Access toolbar. The Save Drawing As window will appear 
in your graphical display. In the Save In list box, select your drawing folder.  Type 
“Revolving Problem 1” in the File Name textbox and hit the Save button to save the 
drawing (Figure 12.36). 
  

 
Figure 12.36 – Saving Revolving Problem One 
 
* World Class CAD Challenge 03-11 * - Close this drawing file.  Create a New file and 
draw the solid using the techniques in this chapter. Move the finished solid to the origin 
of the drawing.  Complete the task in less than 5 minutes.  Continue this drill four times, 
each time completing the drawing in less than 5 minutes to maintain your World Class 
ranking.   
 
* World Class CAD Challenge * - Report your best times to World Class CAD at 
www.worldclasscad.com to obtain your world class ranking. 
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